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TIPS FOR NEW INTERNET USERS

Shop around for Internet service providers. Chances are that if your col-
lege or university provides access, that will be the best deal you can get.
Otherwise, check our list in Part One under “Internet Service Providers
(ISPs)” before you sign a contract!

Find the best time of day to connect to the Web. In many places, early in
the morning or late at night is the best time to do most of your Internet
work, especially if it involves downloading big files. You can work much
faster by working a little smarter.

To speed your download time, turn off the Auto Load Images option (from
the Options menu) on your browser. Most of the time, you want to see the
text first, and if there are also images you want to see, you can turn Auto
Load Images back on and select Reload (from the View menu).

When you find a page you like on the Internet, be sure to set a Bookmark
so that you can come back to it later. (See the Quick View about using
Netscape and other graphical browsers.)

If you are doing research on the Web and find something important, print
that page. It may not be there when you (or your teacher) want to come
back to it, because pages sometimes are deleted or moved.

Once you get on the Internet, you may want to change your start-up page
to a page you choose—such as your favorite search engine’s first page—
rather than your Internet service providers page. For more customization
options, see your browser’s preferences section (on the Options menu).

Once you start downloading files from the Internet, it is easy to run out of
space on your hard drive. Clean it up regularly, deleting old files and opti-
mizing disk space.

When you are sending e-mail, type addresses carefully. One mistake will
make your mail undeliverable, and the Internet does not always let you
know it wasn't delivered.

If you want more information on an Internet topic, check for its
Frequently Asked Questions (FAQ) list. Type the topic name and the let-
ters FAQ into the text box of a search engine, such as Yahoo!

Don't be afraid you will hurt the computer. You won't. The best way to learn
how to do something on a computer is to explore, to play with it a little.
Especially when it comes to the Internet, do not worry—you won't break it.
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INTRODUCTION

What Can the Internet Do for You?

The Internet is a vast resource not only for information, entertainment, and
interaction with other people in other places who share your interests, but also
for learning. You can do everything from reading newspapers and magazines to
learning how to create your own Web page, to videoconferencing, to watching
video clips from your favorite movies, to downloading free software for your
computer, to taking a virtual tour of the National Gallery.

Beyond all those uses, the Internet frees you from the physical boundaries of your
campus, your city, your state, and your country. Information from Japan or Ger-
many or Australia can come 8 you

across the hall. Because the FhigfneT88 alWays Hpe 'fu’ ’ i :
accessible than the informatfpy i ﬂ:ma vegd is
tiny, with access to the Interfgef; a tnférnid Wity ips
than the biggest library anyvghere. All y d to flgis leﬂlow to findit. To
help you find information off the Intern ickl doCpsaent it correqgly is
the purpose of this book. ﬁe i g

In this guide you will leats SEETEREESSE
One), how to use the Internet to communicate with other people and some
precautions you should take (Part Two), and how to use the Internet to find a
job or internship (Part Three). Part Four offers you a list of Internet Resources
specifically designed to help you do research in the Humanities. As you use this

guide you will be introduced to new terms and phrases. If you find yourself
confused, re-read Part One and consult the glossary:.

What Are the Internet and the World Wide Web?

The Internet is a global network of computers. It is composed of many parts, such
as Web documents, e-mail, Telnet, file transfer, Usenet (newsgroups), and
Gopher. The Internet was user hostile until the World Wide Web came along.
The Web is a huge number of sites of information within the Internet. Not only does
the Web make accessing the Internet easier, but it also makes the Internet more
fun because of the Web’s hypermedia capabilities, such as audio, video, 3-D
images, virtual reality, real-time communication, and animation. So let us help
you get started!



QUICK VIEW
How CAaN I Use GRAPHICAL ACCESS TO THE INTERNET?

Some students have access to computers that already have Netscape, Explorer, or some
other graphical browser. If that’s your situation, this page will get you off to a fast
start. The rest of this guide will provide more detailed directions.

Using Netscape and Other Graphical Browsers

To access the Web’s multimedia capabilities, you need a graphical browser, such
as Netscape or Microsoft’s Internet Explorer. (Note: You also need TCP/IP
software; see page 4.) Netscape is used in the following description; other
browsers, such as Explorer, work in essentially the same way.

Click on the Netscape icon to launch the program. The first Web page you
see will depend on your Internet service provider (ISP). Most providers have
designated a Web page to appear when you start Netscape. Many people like
their first screen to be a search engine, such as Yahoo! <http://www.yahoo.
com>. The Netscape Help button will show you how to change your start-up
page.

There are several ways to access a Web page using Netscape. First, you can
follow a hyperlink, which can be either text or an image. Textual hyperlinks, or
hypertext, have a different look from the rest of the text. Depending on the
browser you use, hypertext will either be a different color or it will be under-
lined, or both. To follow a link, use your mouse to drag the arrow over the
hypertext. When positioned over a link, the arrow will turn into a hand. Click
the mouse, and you will go to that Web page. (Some links on some pages are not
marked, but whenever your cursor arrow turns into a hand, you can click there
and be taken somewhere else.)

Another option to clicking a link is to type out a page’s address (called the
uniform resource locator, or URL). Click on the Open button on the toolbar,
type the URL in the box provided, and press Return. To navigate through a
sequence of pages you have already seen, use the Back and Forward buttons
on the toolbar. You may also access a Web page you have already seen by
choosing it from your list of Bookmarks, from entries on the History list (from
the Window menu), or from the Go menu.

(Note: All URLs in this book are enclosed in angle brackets, < >, for readabil-
ity. The brackets are not part of the address.)



QUICK VIEW
How CAaN I Use Texr-ONLY AcCCEss TO THE INTERNET?

Some students have access to computers that will give them only text from the Internet.
If your computer gives you access to Lynx or some other text-only browser, this page
will help you get off to a fast start. The rest of this guide provides more detailed
instructions.

Using Lynx and Other Text-Only Browsers

Lynx is the most popular text-only browser. With text-only browsers, you
cannot view the multimedia functions on the Web, such as pictures, audio, or
video. You see only text. (Note: You do not need TCP/IP software to use Lynx.)

If you have a computer account at school, find out if it is a UNIX or VMS
account. Chances are it will be a UNIX account. (Lynx runs on both, but our
example shows how it works on UNIX.) Next, find out whether Lynx is avail-
able; if so, you can access Lynx by logging on to your computer account and
then on to Lynx. After logging on, you will see either a $ ora %. Then type
lynx. Your screen will look like this:

$ lynx

The first screen displayed should be a page containing information about the
World Wide Web and giving you access to other pages.

To access a specific Web page, type lynx followed by the specific Web page’s
Internet address (its uniform resource locator, or URL). For example, if you
wanted to go to Netscape’s home page, your command line would look like this:

$ lynx http://www.home.netscape.com

When you view a Web page, the hypertext links (shortcuts to other pages)
will appear in bold. To move your cursor to a link (in bold text), use your up
and down arrow keys. When you place your cursor on the bold text, the text
will become highlighted. To follow the link, press the right-arrow key. To go
back, press the left-arrow key.

At the bottom of the screen, you will find a list of other commands. Simply
type the first letter in the command name to execute that command. When you
are finished, type q to quit. You will be asked if you really want to quit; type y
for yes. This will bring you back to your system prompt (the $ or the %).

(Note: All URLs in this book are enclosed in angle brackets, < >, for readabil-

ity. The brackets are not part of the address.)
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PART ONE
FINDING INFORMATION ON THE INTERNET

The Internet started in the 1960s as a project by the U.S. government to link
supercomputers; eventually, its networking technology was used by academic
institutions. In the beginning, the Internet was user hostile, and the numbers of
computers and people it connected were limited. With the creation of the World
Wide Web in the early 1990s by Tim Berners-Lee in Switzerland, the Internet
became much more user friendly. Today, the Internet, a global network of
computers, has a great many parts: the World Wide Web, Usenet, Gopher,
Telnet, and FTP (file transfer protocol).

Technically, the World Wide Web is an Internet facility that uses hypertext to
link multimedia sources. Web servers store files that can be viewed or down-
loaded with a Web browser via HTTP (hypertext transfer protocol). The most
popular text-only browser is Lynx; some popular graphical browsers are
Netscape, Explorer, and AOL (America Online).

How the Internet Works—In Brief

To find the information you want, you should know a little about how your
computer works with the Internet. That is the subject of the next five sections.
If you are not interested in learning more about how computers work, you can
skip to the section “How to Find the Information You Want” on page 7.

Hardware and Software
To gain access to the Internet, you need a computer with the appropriate
hardware and software and an Internet service provider (ISP). Some popular
ISPs are AOL, CompuServe, and Netcom. To access the Internet from home,
you need a computer with a modem to connect your computer to the phone
lines. Most modems run at 28.8K bps (bits per second). Faster modems can
save you money if you are charged by the amount of time you spend on the
Web. You will need a computer that has at least 8 megabytes (MB) of RAM
(random-access memory). (Note: You will also need to find out the networking
capa-bilities of your ISP; information is transferred only as fast as your ISP
slowest connection.)

For software, you will need TCP/IP (transmission control protocol/Internet
protocol, or languages that allow computers to communicate with each other)
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to provide an interface between your computer and the Internet. If you have a
Macintosh, you need MacTCP If you have an IBM or clone, you need Winsock
(which stands for “Windows socket”). Generally these networking protocols
are already provided with your computer operating system. There are two main
types of browsers: graphical and text-only, explained in more detail on pages

2 and 3.

Client/Server Systems

The Web works on a client/server system. The client is your computer and
software; a server is any computer that houses files (text, audio, video, soft-
ware) you want; and networks are systems that connect clients and servers.
Think of your computer (the client) as a customer in a restaurant and the
information provider (the server) as the chef. You order a meal (the informa-
tion), and the waiter or waitress (the network) brings it back to you (your
computer).

URLs and How They Work

To access a file by means of a Web browser, you must know its location. A
URL (uniform resource locator), the Internet address for a file, is composed as
follows:

protocol://server and domain name/file path/file

For example, suppose a student named Jane Smith at the University of
Tennessee, Knoxville, has created a personal Web page for her résumé. The
address for that page is as follows:

http://funnelweb.utcc.utk.edu/~jSmith/Resume.html

Here, http is the protocol; funnelweb.utcc.utk.edu is the server
and domain name; ~jSmith is the file path; and Resume . html is the file.
When we type this address in Netscape or Lynx, the browser reads the URLs
components to find the specific page. Our computer has to know what kind of
protocol, or language, to speak in order to communicate with the server. The
first part of the URL not only tells us what type of file we are accessing, but it
also tells the computer what kind of language it needs to speak. In this case, we
want a Web page in HTML (hypertext mark-up language), so the computer
needs to speak hypertext, using HTTP (hypertext transfer protocol).

The next thing our computer needs to know is where the file is kept. This is
what the second part of the URL, the server and domain name, tells us. The
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server where the Web page in this example is kept is called funnelweb. The
funnelweb server is a computer at the University of Tennessee, Knoxville (UTK)
that is denoted by utcc.utk.edu. The . edu lets us know that the domain
is “educational.” Other types of domains are . com for “commercial”; .mi1 for
“military”; . org for “organizational”; . net for “network”; and . gov for
“governmental” sites. Seven new domain categories were added: . £irm for
“business”; . store for “retail”; . nom for “individual”; . rec for “recreational”;
.info for “informational”; . arts for “cultural”; and .web for “Web
oriented” sites.

Of all the Web pages at UTK, how does your computer know which one is
Jane Smith’s? The last two parts of the URL tell how to get to Jane Smiths file.
(Note the tilde symbol [~], which lets us know that we are looking for a
personal page. This is not unique to UTK, but standard for many personal
pages.) The user identification for Jane file path, or “user area,” is ~jSmith.
The file we want is Resume . htm1. Now that our computer knows where to
go, which file to get, and how to read it, the computer can display Jane Smith'’s
page in Netscape. Notice that the file name has a mix of upper and lowercase
letters. Most URLs are case sensitive, so be sure to enter the URL exactly,
including the uppercase letters. Note also that URLs never contain spaces.

Downloading Information

When you access a page, it sometimes takes a long time for the page to appear
on your screen. If you are using Netscape and look at the bottom of the browser
window while waiting for a Web page to appear, you should see a percentage of
the amount of data transferred. When you access a Web page, a copy of the file
is transferred to your computer’s memory. This is called downloading a file. So,
when you are surfing the Web, copies of all those Web pages are downloaded
to your computer. However, the file is not downloaded all at once; it is trans-
ferred in pieces, or packets. Depending on the size of the files you are down-
loading, the length of time it takes for the Web page to appear will vary: A large
Web page or a Web page with lots of graphics will slow the transfer. Image files
are larger than text files and take longer to download. To shorten the download
time in Netscape, turn off Auto Load Images (from the Options menu). To
remove the check mark, click on Auto Load Images. To turn Auto Load Images
back on, simply click on that line and it will be reactivated. By turning off
Images, Web pages containing graphics will download faster, but you will not
see any of the graphics automatically. To see the graphics individually, you have
to click on the picture frame, or to see all the graphics at once, turn Auto Load
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Images back on and click on Reload (from the View menu) or on the Reload
button on the toolbar.

Internet Service Providers (ISPs)

Before looking into commercial ISPs, check with your college or university’s
computing center because some schools offer Internet services for home access
to students, faculty, and staff. Internet services through your school will probably
be the best deal. Although they may not always have the latest upgrades of
hardware or software, the price will probably be hard to beat.

If you decide to go with a commercial ISP, you should do some comparison
shopping. Think about what you will be using your Internet connection for,
such as e-mail, Internet mail, graphical access to the Web, file transfer, Telnet,
or storing Web pages. Once you decide what you will need, find out which ISPs
offer all those services. After you have gathered a list of possible providers, ask
some questions:

» What is the level of customer support, such as online help, user manuals,
and telephone support (preferably 24 hours)?
¢ Is there an installation fee?

* s there an extra cost for e-mail? If so, is the charge by message, by time, or
by size of the message? Is there a storage fee for mail?

* Are there different rates for access at different times of the day?
* Is there a local dial-in number? Will long-distance fees be charged?
* What is the bandwidth (size of the bandwidth can affect access speed)?

* Is all the necessary software provided, such as TCP/IP and a browser (such as
Netscape or Explorer)?

o s storage space available for Web pages? If so, what is the charge?
* Are back-up servers available to help maintain continuous access?

* What kind of security is offered?

How to Find the Information You Want

The Internet is a vast and rapidly changing conglomeration of information.
Finding your way to the particular piece of information you need can be
difficult if you are not familiar with the search options available.
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World Wide Web Search Engines

You can search the Web with search engines such as Yahoo! or AltaVista;

you can search FTP archives with Archie and ArchiePlex; you can burrow
through Gopher with Veronica, Archie, Jughead, and Gopher Jewels; and
you can access library computers directly with Hytelnet <http://www.cam.ac.
uk/Hytelnet/>. Sometimes the problem is not finding enough information; more
often the problem is finding too much information; and always the problem is
finding the right information. Here are some suggestions for solving these
problems.

Search engines are computer programs that allow you to find the informa-
tion you want through key word searches. The search engine provides a text
box, into which you type key words associated with the information you want.
Most search engines also offer more complex searches involving some variation
of Boolean logic with the aid of “logical operators,” such as AND, OR, and
NOT. (Some search engines use a variation of Boolean searching by letting “+”
stand for AND and “-” stand for NOT.) Some even offer more advanced search-
ing, such as limiting your search to specific dates or ranking key words in order
of appearance within the document.

There are hundreds of search engines for the Internet—too many to discuss
here. Two popular and different types of search engines, Yahoo! (a searchable,
browsable directory) and AltaVista (a powerful search engine), are briefly
described below. For a more extensive list of search engines, see Netscape’s list
at <http://home.netscape.com/home/internet-search.html>.

Yahoo! <http://www.yahoo.com> Yahoo! is both a search engine and
a directory made of subject trees. A subject tree is a hierarchical index system
for finding information. You begin with a general subject, such as Medicine,
and follow the subject tree’s branches to a specific document. Yahoo!’s subject
trees begin on its main page, which can be found at its URL.

Yahoo! is a good way to start searching because it looks at only a few key
elements. Consequently, Yahoo! is the place to go for general discussions of
your topic. To learn more about how to do a search on Yahoo!, click on the
Options link located by the text box where you type in your key terms.

AltaVista <http://www.altavista.digital.com> Unlike Yahoo!, AltaVista
does a thorough full-text search of documents for the key terms. If you put a
fairly general key term into AltaVista, you will most likely receive hundreds or
even thousands of links to pages that may only mention your topic in passing.
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AltaVista is a good place to search for obscure items or for very specific topics.

If you are getting too many hits for a topic on AltaVista, try doing the same
search on Yahoo!; this should cut down the number of possible matches.
Likewise, if you are searching on Yahoo! and you are not getting enough
matches, try AltaVista.

AltaVista offers both a Simple Search and an Advanced Search. The Ad-
vanced Search helps you limit your results by specifying date ranges and
ranking key terms. To find out more about Simple and Advanced Searches on
AltaVista, click the Help button at the bottom of the first AltaVista page.

Searching via Key Words

Key word searches may require some imagination if you are not getting the
results you hoped for. In most cases, your search was either too narrow or too
broad. The tips below should help. Also, when you do find information you
want, remember to check it for credibility. (See pages 12—15 on how to judge
the reliability of Internet information.)

Narrowing a Search If you are getting too many hits (successful key word
matches), try narrowing your search by adding more key terms. Sometimes this
will help, because most search engines will look for each of the terms indepen-
dently but display the pages with the most matches first. Usually, you can
narrow your search and make sure that all the key terms appear in the docu-
ment by using AND between the key terms.

B Info Bit—Narrow your search by looking for the most current information (or
for the most relevant dates) in the AltaVista Advanced Search by entering a starting
and ending date for the information.

‘/6 Info Bit—Some search engines, such as Yahoo!, allow you to search within
document titles only. This will narrow your search results and may give you better
sources on your topic.

Broadening a Search If you are not getting enough hits, you need to
broaden your search by deleting some of the more specific key terms or
substituting synonyms for the key words you already have listed. For example,
for a search about how to make a Web page, you might try several search
strings, such as “Web page design,” “creating a Web page,” and “making a Web
page.” Also, you may want to try a more general category under which your
topic falls. For example, if you want information on the Hopi god Kokopeli, but



